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Chapter 1: Introduction
This guide explains how to configure a system 
running Pro Tools® software as a Unity Media-
Network® client within an Avid® MediaNetwork 
system. It also explains how to exchange audio 
and video media between Pro Tools and Avid 
video editing application clients (such as 
Media Composer and Symphony) attached to a 
MediaNetwork system.

This guide is written for Avid network adminis-
trators, Pro Tools users, and Avid video editor 
users.

Avid MediaNetwork 
Capabilities
Avid Unity MediaNetwork is a Fibre Channel 
shared storage system that lets users of Avid ed-
iting applications and Pro Tools share the same 
media, as follows:

• Stream audio and video media in real time. 

• Configure multiple users on the same 
MediaNetwork system.

• Share AAF and OMF sequences, and OMF and 
MXF audio and video media.

• Share AAF sequences, and MXF media, using 
the Avid Interplay asset management system 
(Avid Interplay system required).

Systems running non-HD Pro Tools soft-
ware can also act as MediaNetwork clients, 
but media streaming is not supported in this 
configuration.
Avid Interplay
Avid Interplay with the Pro Tools Avid Inter-
play® option lets Pro Tools and Avid users work 
within the same asset management system. 

Refer to the Pro Tools Avid Interplay 
Guide for detailed information.
Chapter 1: Introduction 1
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Overview of a MediaNetwork 
System
This guide describes how to configure and work 
with a Pro Tools client within an Avid Media-
Network system. The MediaNetwork installa-
tions addressed in this guide typically comprise 
the following components:

MediaNetwork System Entire set of components 
within an individual MediaNetwork installa-
tion.

MEDIASwitch One or more central routers di-
recting communication between different com-
ponents within a MediaNetwork system.

PortServer or PortServer Pro (Optional) One or 
more servers that let Avid workstations access 
MediaNetwork workspaces through an Ethernet 
connection (without a Fibre Channel connec-
tion).

File Manager One or more servers (including a 
backup server) that functions as the heart of the 
Unity MediaNetwork file system by maintaining 
location information for media stored on drives.

JBOD/IBOD Chassis that contains the drives that 
store the actual data.

Avid Interplay Transcode and/or Avid DMS ProEn-
code (Optional) Engine that distributes proces-
sor-intensive tasks to network servers in order 
to allow MediaNetwork clients (such as Avid 
and Pro Tools workstations) to proceed without 
interruption.

Avid Interplay Access or Avid Unity MediaMan-
ager (Optional) Media asset management client 
application that enables facility-wide searching, 
sorting, cataloging, management, and retrieval 
of media.
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Avid Interplay Assist or Avid Unity MediaManager 
Select (Optional) Client that allows real-time 
logging and annotating of any media right at the 
desktop.

Avid Interplay Engine or Avid Unity MediaMan-
ager Server (Optional) Server that manages the 
metadata stored on the File Manager server.

Clients One or more Avid or Pro Tools worksta-
tions configured to be able to exchange data 
with other clients attached to the MediaNetwork 
system.

Avid Unity MediaNetwork system (solid lines 
represent physical connections, while dotted lines 
represent connections through the switch)
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AAF, OMF, and MXF Basics
AAF and OMF files are mechanisms for storing 
and retrieving media data and metadata so that 
projects can be freely exchanged between differ-
ent applications and platforms (such as between 
Pro Tools and Avid video editing applications).

Media data and metadata enable an application 
that receives AAF and OMF sequence files to au-
tomatically and quickly reassemble the compo-
sition. A simple metaphor for this approach is 
that media data files are the pieces of a puzzle 
and metadata is the set of instructions for as-
sembling the puzzle.

In the simplest case, only an AAF or OMF se-
quence is exchanged. If this sequence points to 
existing media files, the size of the sequence file 
is relatively small and the export/import process 
is relatively fast. 

AAF and OMF sequences can also have media 
data embedded in them. This creates a single, 
larger file that is slower to export and import, 
but which may be easier to manage than thou-
sands of files stored on different volumes. 

Pro Tools supports AAF and OMF sequences 
that contain embedded audio media. 

Pro Tools does not support AAF or OMF se-
quences containing embedded video media, ex-
cept if you are importing such sequences into a 
video satellite track. In such cases, video meta-
data is imported into the track.
MXF
MXF is a media file format. There are MXF video 
files and MXF audio files, but there are no “MXF 
sequences.” An AAF sequence may refer to or in-
clude MXF media files, but OMF sequences can-
not refer to or include MXF files.

Avid Support for MXF Media

Avid video editing applications support MXF 
media as follows:

• Creation of MXF media when capturing, 
transcoding, rendering, or using other meth-
ods to create media

• Import of MXF media files created in other 
Avid applications

• Export of MXF audio and video files

Pro Tools Support for MXF Media

Pro Tools supports MXF media as follows:

• Import of MXF video and audio media

• Export of MXF audio media

Pro Tools cannot export video files of any type.

Video files digitized in Pro Tools are technically 
of the MXF format, but are intended only for use 
in Pro Tools and are not tested for compatibility 
with other applications.
Chapter 1: Introduction 3
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AAF
AAF sequences are the best way to exchange 
projects and maintain valuable metadata. An 
AAF sequence can refer to OMF and/or MXF me-
dia files, or have OMF and MXF media files em-
bedded within them. There is no such thing as 
an AAF audio or video media file. 

Avid Video Editing Application Support 
for AAF Sequences

Avid video editing applications support AAF se-
quences as follows:

• Import and export of AAF sequences with em-
bedded video files (MXF or OMF) and/or au-
dio files (MXF, WAV, or AIFF)

• Import and export of AAF sequences that refer 
to external (linked) video files (MXF or OMF) 
and/or audio files (MXF, WAV, or AIFF)

Pro Tools Support for AAF Sequences

Pro Tools supports AAF sequences as follows:

• Import and export of AAF sequences that con-
tain embedded or refer to external (linked) 
MXF, WAV, or AIFF audio files 

• Import of AAF sequences that refer to external 
(linked) MXF or OMF video files

• Video satellite systems only: Import of AAF 
sequences containing embedded video to a 
satellite track, in which case Pro Tools im-
ports only the metadata (cuts and clip names) 
and not the video

Pro Tools does not export video files, tracks or 
metadata as part of AAF sequences.
Pro Tools Avid Unity MediaNetwork Guide
OMF
OMF is both a media file and sequence format. 
OMF media files can be audio or video.

Avid Video Editing Application Support 
for OMF Media and Sequences

Avid video editing applications support OMF 
media and sequences as follows:

• Import and export of OMF sequences with em-
bedded OMF video files and WAV or AIFF au-
dio files

• Import and export of OMF sequences that re-
fer to external (linked) OMF video files and 
WAV or AIFF audio files

Pro Tools Support for OMF Media and 
Sequences

Pro Tools supports OMF media and sequences 
as follows:

• Import of OMF video files created by 
Media Composer or other Avid applications

• Export of OMF audio files

• Import and playback of OMF sequences that 
refer to external (linked) audio files or contain 
embedded audio files

• Import and playback of OMF sequences that 
refer to external (linked) OMF video files

• Export of OMF sequences that refer to exter-
nal (linked) audio files or contain embedded 
audio files

• Video satellite systems only: Import of OMF 
sequences containing embedded video to a 
satellite track, in which case Pro Tools im-
ports only the metadata (cuts and clip names) 
and not the video

Pro Tools does not export video files, tracks or 
metadata as part of OMF sequences.



Embedded Media
Exporting to OMF or AAF with embedded media 
results in one large OMF or AAF file containing 
both the metadata and all associated media files.

Media Data (Media Files)
Media data represents raw audio or video mate-
rial and is stored in individual media files. Every 
time you record a piece of video or audio mate-
rial into an application, you are creating a media 
file containing media data. Audio media data is 
stored as samples (such as 44,100 or 48,000 sam-
ples per second of recording) while video media 
is typically stored as frames (24, 25, or 30 frames 
per second of recording).

The size of each media file depends on how 
much audio or video material it contains. For 
example, if you record ten minutes of continu-
ous video material at a high resolution, you 
might end up with a video media file that is 
1.8 GB in size, whereas a one minute recording 
at the same resolution might result in a 180 MB 
file. Media files tend to be large, since high qual-
ity audio and video signals are data intensive. 
Video data generally requires considerably 
more storage than audio data.

MXF Media Data Locations On the volumes you 
have designated for media storage, Avid editing 
applications store all MXF media:

• When stored locally, MXF media is placed in 
the Avid MediaFiles/MXF/1 folder. The Avid 
editing application can also read MXF media 
located at Avid MediaFiles/MXF/2, Avid Medi-
aFiles/MXF/3, and so on.

• When stored in a shared environment, MXF 
media is placed in a folder called 
Avid MediaFiles/MXF/client.1 (where client 
represents the name of the client computer).
This guide refers to the root folder name (Avid 
MediaFiles) whenever referencing this folder.

OMF Media Data Locations On the volumes you 
have designated, Avid editing applications store 
all OMF media in the OMFI MediaFiles folder.

Metadata
Metadata is used to describe:

• Information about each media file. This 
may include sample rate, bit depth, clip 
names, the name of the videotape from 
which the media file was captured, and 
even timecode values that specify where a 
file was used in a Pro Tools session.

• Information about Pro Tools sessions or 
other sequences, including what files are 
used, where they appear in a Timeline, and 
automation.

• For AAF or OMF sequences, metadata also 
includes information about unrendered 
AudioSuite effects (such as real-time EQ) 
on Avid workstations. Pro Tools skips un-
rendered effects on import. Rendered ef-
fects are media files, that can be imported 
or skipped on import into Pro Tools.

• For AAF or OMF sequences, information 
about automation (clip-based gain or key-
frame gain).
Chapter 1: Introduction 5
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Embedded Media and Linked 
Media
There are two ways to handle media files when 
exporting AAF or OMF files: 

• Embedded media (in which the media files are 
embedded in an AAF or OMF sequence)

• Linked media (in which media files are refer-
enced by an AAF or OMF sequence)

Pro Tools lets you import AAF or OMF se-
quences containing embedded audio files. You 
can also import AAF or OMF sequences contain-
ing embedded video files, but only if you are im-
porting them to a video satellite track. In such a 
case, only the video metadata is imported.
Pro Tools Avid Unity MediaNetwork Guide
Frame-Rate Accurate Video 
Editing and Sample-Rate 
Accurate Audio Editing
Avid video editing applications edit with frame 
accuracy. This means that in a 30-fps project, 
you can edit at 30 different locations for every 
one second of video. Pro Tools edits with sample 
rate accuracy. In a 48 kHz session, there are po-
tentially 48,000 locations to edit for every sec-
ond of audio. 

When Pro Tools exports an AAF or OMF compo-
sition destined for an Avid video editing appli-
cation, it must ensure that the audio files line up 
on frame boundaries. To do this, it might have 
to split an existing audio clip into three separate 
clips. For example, Figure 1 on page 7 shows a 5-
frame video clip and a corresponding audio clip. 
In Pro Tools, the audio clips might not line up 
on video frame boundaries.

In order to export frame accurate audio clips, 
Pro Tools splits the audio media on frame 
boundaries and fills any gaps with silence. 
Figure 2 on page 7 shows the resulting audio 
clips that are exported to Avid. See

When you use Export Selected Tracks as 
OMF/AFF to export tracks from Pro Tools with 
Enforce Avid Compatibility enabled, a number 
of additional media files labeled Sample Accu-
rate Edit appear in the Avid bins. These are the 
additional media files that Pro Tools creates to 
ensure that the Avid editing application receives 
frame-accurate audio. You also see the sample-
accurate edit media files if you zoom in on the 
imported audio in the Timeline.



Figure 1. Original audio clip

One Pro Tools audio clip

5 frame video clip

The original audio clip does not line up on video frame boundaries
Figure 2. Exported audio clip

Three exported audio clips

5 frame video clip

Exported audio clips line up on video frame boundaries

New audio clip padded 
with silence

New audio clip padded 
with silence
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System Requirements and 
Compatibility
Using Pro Tools within a Unity MediaNetwork 
system requires the following;

• A qualified Mac computer running Mac OS X 
or PC running Windows 7

• Pro Tools HD software

• An available expansion slot for a Fibre Chan-
nel host bus adapter (HBA), and Fibre Channel 
connectivity to the Avid Unity MediaNetwork 
server

• MediaNetwork client installation software

Avid can only assure compatibility and provide 
support for hardware and software it has tested 
and approved. 

For complete system requirements and a list of 
qualified computers, operating systems, hard 
drives, and third-party devices, visit:

www.avid.com/compatibility

Systems running non-HD Pro Tools soft-
ware can also act as MediaNetwork clients, 
but media streaming is not supported in this 
configuration.
Pro Tools Avid Unity MediaNetwork Guide
About Avid Unity 
MediaNetwork Guides
PDF versions of Avid Read Mes are installed au-
tomatically with Avid Unity MediaNetwork soft-
ware. Also, searchable online help files contain-
ing the same information are accessible from the 
Help menus in the Interplay Access and Inter-
play Administrator applications.

You can use any of the following guides as sup-
plementary information for this guide.

• Avid Site Preparation Guide contains informa-
tion that helps you prepare your site for in-
stalling MediaNetwork system hardware.

• Avid Unity MediaNetwork Management Guide 
provides information for the setup and day-to-
day management of an Avid Unity Media-Net-
work system and system. 

• Avid Unity MediaNetwork Windows Fibre 
Channel Client Setup Guide provides informa-
tion for setting up MediaNetwork client hard-
ware, installing and configuring 
MediaNetwork client software, and creating a 
network of MediaNetwork clients and other 
systems.

These guides and other Avid documentation can 
be found on the Avid Knowledge Base. You can 
reach the Knowledge Base by clicking Help > 

Pro Tools Knowledge Base in Pro Tools, or by 
visiting www.avid.com/onlinesupport. To view 
or print PDF guides, use Adobe Acrobat Reader.



About the Pro Tools Avid 
Interplay Guide
The Pro Tools Avid Interplay Guide describes 
how to set up Pro Tools as a client within an 
Avid Interplay system, as well as use Pro Tools 
and Interplay to exchange sequences between 
Avid and Pro Tools users. Please refer to the 
Pro Tools Avid Interplay Guide for information 
on working with Interplay and Pro Tools.

Support for Avid Unity 
MediaNetwork
For support on Avid Unity MediaNetwork, visit 
Avid’s online Knowledge Base. You can reach 
the Knowledge Base by clicking Help > 

Pro Tools Knowledge Base in Pro Tools, or by 
visiting www.avid.com/onlinesupport.Online 
services are available 24 hours per day, 7 days 
per week. Search this online Knowledge Base to 
find answers, to view error messages, to access 
troubleshooting tips, to download updates, and 
to read or join online message-board discus-
sions.

For support on Pro Tools HD, see “About 
www.avid.com” on page 10.
Conventions Used in This 
Guide
Pro Tools guides use the following conventions 
to indicate menu choices and key commands:
:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight 
important information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control key 
and press the N key

Control-click Hold down the Control key 
and click the mouse button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your system.

Important Notices include information that 
could affect your data or the performance of 
your system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Avid guides.
Chapter 1: Introduction 9
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About www.avid.com
The Avid website (www.avid.com) is your best 
online source for information to help you get the 
most out of your Pro Tools system. The follow-
ing are just a few of the services and features 
available. 

Product Registration Register your purchase 
online. 

Support and Downloads Contact Avid Customer 
Success (technical support); download software 
updates and the latest online manuals; browse 
the Compatibility documents for system re-
quirements; search the online Knowledge Base 
or join the worldwide Pro Tools community on 
the User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Avid 
products; download demo software or learn 
about our Development Partners and their 
plug-ins, applications, and hardware. 

News and Events Get the latest news from Avid 
or sign up for a Pro Tools demo.
Pro Tools Avid Unity MediaNetwork Guide



Chapter 2: Preparing a Pro Tools Workstation 
For MediaNetwork
This chapter is for Unity administrators and de-
scribes how to install and configure individual 
Pro Tools workstations for use as clients of an 
Avid Unity MediaNetwork system.

Installation Overview
Installing the hardware and software involves 
the following process:

1  Make sure that Pro Tools software is installed 
on the workstation.

2  Install the MediaNetwork client hardware.

3  Install the MediaNetwork client software.
.

Installing Pro Tools
If you plan to configure a Pro Tools workstation 
as a MediaNetwork client, ensure that Pro Tools 
software (and any audio hardware) are properly 
installed. For detailed information, see the 
Pro Tools Installation Guide.

When you update the client software, ensure 
that you update the Fibre Channel HBA 
drivers and firmware to the versions sup-
ported with your current version of Media-
Network.
Ch
Installing MediaNetwork 
Client Hardware
The Avid Unity MediaNetwork client hardware 
consists of:

• One optical SFP (for the Server switch)

• One of the following qualified Fibre Channel 
HBA (Host Bus Adapter) cards:

• ATTO Celerity FC-41XS 4 GB HBA

• ATTO Celerity FC-41ES 4 GB HBA 

You will need to purchase optical cables sepa-
rately. 

For a complete, current list of qualified 
host bus adapters please consult Avid 
support.

The cable needs LC optical cable connectors 
at both ends. 

If a Fibre Channel HBA has ever been in-
stalled on your Windows system, you 
must remove any unused ATTO .INF files 
before installing the ATTO Fibre Channel 
HBA. If you do not know how to do this, 
please contact your Windows system ad-
ministrator.
apter 2: Preparing a Pro Tools Workstation For MediaNetwork 11



12
To install the Fibre Channel HBA in a client 
workstation:

1  Shut down and power off your computer and 
expansion chassis (if one is present). 

2  Open your computer according to the instruc-
tions included with it. 

3  Release any static electricity by touching the 
power supply, or another grounded item.

4  Remove the Fibre Channel HBA from the anti-
static bag, being careful to handle it only by the 
edges.

5  Determine the correct PCI/PCIe card slot or-
der (visit www.avid.com for the latest informa-
tion).

6  Line up the Fibre Channel HBA with the instal-
lation slot, and slide the card into place gently so 
the PCI/PCIe connector is aligned with the cor-
rect PCI/PCIe slot.

7  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI/PCIe slot.

8  To attach the card bracket to the computer 
mounting bracket, fasten the card in place using 
a screw or latch down the securing bracket if one 
is built in.

To connect a Fibre Channel optical cable to the 
Fibre Channel HBA:

1  Locate the optical cable with the LC optical ca-
ble connector (dual plug) on the end.

2  Remove the protective covers from the follow-
ing:

• LC optical connector on the optical cable

• Fibre Channel HBA in your computer
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3  Plug the optical cable connector into the Fibre 
Channel HBA. The connector and the Fibre 
Channel HBA are keyed and only fit together one 
way. You should hear a click when the cable is 
properly seated.

4  If the other end of the cable is not yet con-
nected to the MEDIASwitch, do so now. For de-
tailed instructions, see the Avid Unity 
MediaNetwork Configuration Guide and the Avid 
Unity MediaNetwork Site Preparation Guide.

Do not try to force the LC optical cable con-
nector into the Fibre Channel HBA connec-
tor. There should be no resistance as you 
make the connection. If you feel that the op-
tical cable connector does not fit into the Fi-
bre Channel HBA connector, turn the opti-
cal cable connector 180 degrees and try to 
insert the optical cable connector into the 
Fibre Channel HBA connector again.

Connecting the optical cable to the Fibre Channel 
HBA

LC optical connector
optical cable

Fibre Channel HBA Green and Yellow LEDs



Fibre Channel HBA LED States

The LEDs on the Fibre Channel HBA indicate 
whether or not the card is functioning correctly. 

Table 1. ATTO Celerity FC-41ES and FC-41XS 4 Gb Fib
Ch
re Channel HBA LED states
LED LED State Meaning

Link Green Indicates that a supported hardware driver is loaded for the ATTO 
Celerity card in its host system, and that another hardware device is 
detected at the other end of the connected fibre cable.

2 GB Green Indicates that the HBA is running in 2Gb mode.

4 GB Amber or Green Indicates that the HBA is running in 4Gb mode.
apter 2: Preparing a Pro Tools Workstation For MediaNetwork 13
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Installing MediaNetwork 
Client Software
The MediaNetwork client software lets the Mac 
or Windows Fibre Channel-equipped client log 
in to the MediaNetwork File Manager and to 
map accessible workspaces. The client software 
is supplied on the MediaNetwork Release DVD-
ROM in the Mac or Windows client kit.

Installing MediaNetwork client software in-
volves the following steps:

1  Install the Fibre Channel Controller driver.

2  Install the MediaNetwork client software.

Installing the Fibre Channel 
Controller Driver
After you install the Fibre Channel adapter 
board in the client, you need to install the latest 
Fibre Channel adapter driver. The Avid Unity 
MediaNetwork DVD-ROM contains an  ATTO™ 
driver specific for your board. See the Avid Unity 
Media Engine and  Avid MEDIArray XT ReadMe 
for the instructions on loading the driver and 
firmware if  needed.

Installing the MediaNetwork 
Client Software

To install the MediaNetwork client software (Mac):

1  Insert the MediaNetwork DVD-ROM into the 
OS X client DVD-ROM drive. The  MN x.x DVD-
ROM icon appears on the desktop, where x.x is 
the software version  number.

2  Double-click the MN x.x DVD-ROM icon. The 
MN x.x window opens.

You must have a supported version of Mac 
OS X or Windows 7 installed before you in-
stall the MediaNetwork client software.
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3  Double-click the Avid Unity Installer icon. A 
login dialog opens.

4  Type a user name and password for a user ac-
count with administrator permissions. The  Avid 
splash screen opens.

5  Click Continue.

6  Read the license agreement and click Accept. 
The Avid Unity Install window opens. If  you 
click Decline, then the installation ends.

7  Select the Easy Install option to install all the 
necessary software on the Avid drive.

8  Click Install. A dialog opens, stating that no 
other applications can be running while  the in-
stallation is in progress.

9  Click Continue. All applications running on the 
workstation quit and a dialog  opens, asking 
which client software you want to install.

10  Do one of the following:

• If you are installing the MediaNetwork soft-
ware on an Avid, click MediaNetwork, and 
then click Install. The MediaNetwork soft-
ware is installed in the Avid Unity folder on 
the Macintosh HD drive.

• If you are installing the MediaNetwork soft-
ware on a Pro Tools Mac client,  click Medi-
aNetwork for Pro Tools, and then click 
Install. The MediaNetwork  software is in-
stalled in the Avid Unity folder on the Mac-
intosh HD drive.

11  Click OK. A dialog opens, asking if you would 
like to Continue, Quit, or Restart the  Mac OS X 
client.

12  Click Restart. The Mac OS X client reboots.



To install the MediaNetwork client software 
(Windows):

1  Insert the MediaNetwork DVD-ROM in the 
DVD-ROM drive. The DVD-ROM is set to  start 
automatically and open the Avid Unity Installa-
tion window. If the DVD-ROM does  not start au-
tomatically, start the installation manually as 
follows:

• Double-click the My Computer icon on the 
desktop.  The My Computer window opens.

• Right-click the DVD-ROM icon, and select 
Play.  The Avid Unity Installation window 
opens.

2  Click Product Installers.

3  Click MediaNetwork Components on the list of 
available products.

4  Click Install Fibre Attached Client on the list of 
MediaNetwork installers. The Question  dialog 
opens, listing the prerequisite software needed 
for installation.

• If all the software is installed, click Next 
and continue with step 5. The InstallShield  
Wizard dialog opens.

• If some of the software is not installed, 
click Cancel to exit the installer. Install the  
prerequisite software, and go to step 1 to 
begin the MediaNetwork installation  again.

5  Accept the default values presented by the In-
stallShield Wizard.  The Setup Status screen ap-
pears, showing the installation progress 
indicator while the  software is being installed.  
The InstallShield Wizard Complete opens.

6  Select “Yes, I want to restart my computer 
now,” and then click Finish to complete the  client 
software installation.

7  Reboot the client.
Ch
Setting the Date and Time
You need to correctly set the date, time, time 
zone, and daylight savings time on your com-
puter to be able to use the Synchronize Time 
with Server function for your MediaNetwork cli-
ent.

To set the date, time, and time zone on Mac OS X:

1  Select Apple System Preferences. The System 
Preferences window opens.

2  Click the Date & Time icon. The Date & Time 
window opens.

3  Click the Date & Time tab. The date and time 
properties appear.

4  In the Today’s Date section, click the arrows 
before and after month and year to change  the 
month and year values.

5  Click the correct day of the month in the cal-
endar.

6  In the Current Time section, click the hours, 
minutes, or seconds, and then click the up  or 
down arrow to change the time values.

7  Click the Time Zone tab. The time zone map 
appears.

8  Click the map near your location to highlight 
the time zone.

9  Click the Network Time tab. The network time 
properties appear.

10  Close the Date & Time window.

11  Reboot the client.
apter 2: Preparing a Pro Tools Workstation For MediaNetwork 15
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To set the date, time and time zone on Windows 7:

1  Right-click the clock icon on the taskbar. A 
menu will appear.

2  Choose Adjust Date/Time from the menu. The 
Date and Time dialog will appear.

3  Click the Change date and time... button.

4  Set the date and time to the correct values.

5  Press OK to close the window.

6  Click the Change Time Zone button and select 
the correct time zone.

7  Make sure that “Automatically adjust clock for 
Daylight Saving Time” is selected.

8  Click OK to save your changes, then close the 
Date and Time Control Panel.
Pro Tools Avid Unity MediaNetwork Guide



Chapter 3: Configuring a Pro Tools System as 
a MediaNetwork Client
This chapter describes how to use MediaNet-
work client software to establish your Pro Tools 
workstation as a MediaNetwork client, and also 
contains additional details on using Pro Tools in 
a MediaNetwork system.

Getting Started Using a 
Workstation as a 
MediaNetwork Client
To get started using your workstation as a 
MediaNetwork client, follow these steps:

1  Log into MediaNetwork: See “Logging into a 
MediaNetwork System” on page 17.

2  Assign the workspace drive letter: See “Assign-
ing the Workspace Drive Letter” on page 18.

3  Mount a workspace on your Pro Tools client: 
See “Mounting and Unmounting Workspaces” on 
page 19.
Chapte
Logging into a MediaNetwork 
System
After installing MediaNetwork hardware and 
client software to your workstation, you must 
log into the MediaNetwork system in order to 
configure and mount MediaNetwork drives.

To log into the MediaNetwork system:

1  Do one of the following:

Mac: If the Connection Manager alias icon is not 
available, select Go > Applications, and then dou-
ble-click the AvidUnity folder. In this folder, 
double-click  the UnityConnectionManager file.

Windows:  If the Connection Manager icon is 
not available in the Windows taskbar,  select 
Start > All Programs > AvidUnity > Avid Unity Con-

nection Manager.

MediaNetwork administrators should pro-
vide users of each Pro Tools client with an 
individual username and password. If you 
do not have a password, contact your ad-
ministrator.
r 3: Configuring a Pro Tools System as a MediaNetwork Client 17
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2  Do one of the following:

Mac:  Double-click the Connection Manager 
alias icon on the desktop, or  double-click the 
Connection Manager alias icon in the dock, and 
then select Connections > Manage Connections.

Windows:  Click the Connection Manager icon 
in the Windows taskbar, and select  Manage Con-

nections.

3  If you are not logged in with a valid MediaNet-
work user name and password, you are  
prompted to supply them before the Avid Unity 
Connection Manager dialog opens.

In the Network Logon dialog (Macintosh) or the 
Login dialog (Windows), type  a valid MediaNet-
work user name, password, and Domain name 
(if necessary), and click  OK.

The Avid Unity Connection Manager dialog 
opens and displays a list of all the  MediaNet-
work workspaces to which you have access.

Assigning the Workspace 
Drive Letter 
(Windows Only)

MediaNetwork workspaces (drives) are auto-
matically assigned a sequential series of alpha-
betical letters starting with the letter f. For ex-
ample, a MediaNetwork system containing three 
workspaces would be assigned the drive letters f, 
g, and h, respectively.

If your MediaNetwork client contains any local 
drive that shares a letter (such as f) with a Unity 
workspace, you must re-map the Unity work-
spaces so that drive letters on the Pro Tools cli-
ent do not overlap with drive letters on Unity 
workspaces. 
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To re-map workspace drive letters:

1  Click the MediaNetwork taskbar icon, and 
choose Configure from the pop-up menu.

2  In the Avid Ethernet Attached Client dialog, 
click Advanced. The Advanced Connection Man-
ager Options dialog appears.

3  From the “Assign Workspace Drive Letters 
Starting With” pop-up menu, select the letter to 
which the first workspace will be assigned. 
(Make sure to select a letter whose range of se-
quential letters does not include any letters as-
signed to drives on your Pro Tools client.)

4  Select “Synchronize the System Clock with the 
Server Clock.” This is necessary to help prevent 
time-related title creation and access problems 
by synchronizing the time of the MediaNetwork 
client to the time of MediaNetwork File Man-
ager.

5  If you want to be notified when the status of a 
workspace connection is lost, select the relevant 
option.

6  Click OK to apply changes.



Mounting and Unmounting 
Workspaces
Mounting a workspace to your Pro Tools work-
station is equivalent to connecting to a network 
drive or mounting a FireWire drive to your com-
puter. Once the drive is mounted, you can con-
nect to that workspace, stream media from it, 
save media to it, and unmount it.

To mount or unmount Unity workspaces using 
your Pro Tools client:

1  Open the Connection Manager.

2  In the Connection Manager window, select the 
Workspaces that you wish to mount or unmount.

3  If mounting a workspace, and you want the 
Pro Tools client to automatically mount these 
workspaces each time you log into the Media-
Network system, select the option at the bottom 
of the dialog.

4  Click Apply.

Configuring Pro Tools 
Session Settings for a New 
Session
The following describes the recommended ses-
sion settings for creating a new Pro Tools ses-
sion when working in a MediaNetwork system.

To create a new Pro Tools session for Avid Unity 
MediaNetwork:

1  In Pro Tools, choose File > New Session.

2  If the Quick Start dialog opens, s
Chapte
3  In the New Session dialog, select an Audio File 
Type for the session that is compatible across all 
workstations.

4  Select a Sample Rate for the session that is 
compatible across all workstations.

5  Select a Bit Depth for the session that is com-
patible across all workstations.

6  Click OK.

7  Name the session and save it to an Avid Unity 
MediaNetwork workspace.

New Session dialog

Pro Tools Session Naming dialog
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Audio File Type

Pro Tools supports AIFF and BWF (.WAV) au-
dio files natively. The BWF sub-formats RF64 
and WAVE Extended are also supported.

For the best media compatibility between 
Pro Tools workstations and Avid workstations, 
you should choose to work with Broadcast WAV 
media files. Make sure the Audio File Type pop-
up menu in the New Session dialog is set to BWF 
(.WAV) when you are creating a new session.

Sample Rate

Pro Tools HD supports sample rates up to 
192 kHz, but other Pro Tools and Avid worksta-
tions only support lower sample rates. There-
fore, when working in mixed MediaNetwork sys-
tems, it is vital to use sample rates for shared 
media that are supported on all workstations.

It is preferable for all participants in the system 
to agree on a standard, universal sample rate for 
the sake of compatibility and to avoid media 
conversion. Many facilities choose 48 kHz, 
which is the industry standard for post produc-
tion and broadcast applications. 

Avid video editing applications do not sup-
port RF64 audio files. Standard.WAV for-
mat is recommended when working in a 
shared media environment with video.

All Sound Designer II files must be con-
verted to a Windows-compatible format.

The WAV file format is required when work-
ing with audio files containing field re-
corder metadata.
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Bit Depth

It is preferable for all participants in the system 
to agree on a standard, universal bit depth for 
the sake of compatibility and to avoid media 
conversion. Many facilities standardize on 24-
bit audio, which offers higher audio quality than 
16-bit, and is more universally supported than 
32-bit floating point audio.

For current compatibility information on 
supported Pro Tools systems and Avid Unity 
MediaNetwork, visit www.avid.com.



Performance Characteristics
You should experience no functional difference 
between working with Pro Tools attached to a 
Unity MediaNetwork system or working with 
Pro Tools attached to local storage. However, 
due to the architectural differences between 
Unity and local storage, some subtle differences 
may be noticeable.

Disk Cache Performance 
Enhancements

Pro Tools HD software version 10 adds a RAM-
based Disk Cache system. With it, audio is 
loaded into RAM for instant playback, increas-
ing performance significantly, especially with 
networked storage (such as a MediaNetwork 
system). 

Allocating a generous amount of RAM to Disk 
Cache allows for higher track counts over Unity, 
closer to standard Pro Tools system maximums.

When playing back large or complex sessions 
(especially from networked storage), perfor-
mance is significantly improved by caching all 
audio in the timeline to RAM, so it can be useful 
to know how much of the audio has been cached.

To check Disk Cache status:

1  Open the System Usage dialog by clicking 
Windows > System Usage.

Pro Tools 10 also lets you use Elastic Audio 
with MediaNetwork.

Pro Tools System Usage dialog
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2  The Timeline Cached gauge displays the per-
centage of audio in the timeline that has been 
cached to RAM. If the Timeline Cached gauge is 
at 100%, all audio in the Pro Tools timeline has 
been cached to RAM.

For more information on Disk Cache and how to 
configure it, see the Pro Tools Reference Guide.

Sharing Allocation Groups and 
Media
Audio and video files can be shared among sev-
eral MediaNetwork clients. However, keep in 
mind the following restrictions when sharing 
Allocation Groups and files:

• Placing audio files for Pro Tools clients in a 
separate allocation group from the video files 
can yield higher throughput and performance, 
but is not necessary under most circum-
stances.

• Pro Tools clients cannot use files that are in a 
shared uncompressed allocation group.

• Each Avid video editing client that is using 
dual-stream 1:1 video must have dedicated ac-
cess to the single-user allocation group con-
taining the video files. No other clients can 
share the video files while these clients are us-
ing them.

The amount of audio that can be cached to 
RAM is dependent on the amount of RAM 
allocated to Disk Cache in the Playback 
Engine dialog in Pro Tools. In cases where 
the total size of all audio on the timeline 
exceeds the amount of allocated RAM, the 
Timeline Cached gauge will not reach 
100%.
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• Only one Pro Tools client can access a finish-
ing allocation group containing 1:1 video files. 
The allocation group may not be used simulta-
neously by a video editing client, and the 
Pro Tools client can only play a single stream 
of video.

• Up to three Pro Tools clients and one video ed-
iting client can access an allocation group con-
taining 3:1 or lower compressed video files.

• In an environment with at least one Avid 
Media Composer client running two streams 
at 1:1 video resolution, the maximum number 
of clients that can normally be supported is 
seven.

• Each finishing video allocation group must 
connect directly to a MEDIASwitch port.

Opening Files
Pro Tools periodically opens and closes files (for 
example, to buffer them for playback). When us-
ing MediaNetwork storage, the file open process 
is somewhat slower than with local storage. This 
is most noticeable when first opening an exist-
ing session. 
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Sharing Files

Sharing Session Files
To avoid machine conflicts among multiple us-
ers and avoid general performance problems, no 
two Pro Tools clients should open the same ses-
sion at the same time. Only one Pro Tools client 
should have a particular session open at any 
given time.

Sharing Video Files
Pro Tools clients with Avid video peripherals 
(such as Avid Mojo, Avid Mojo SDI, and AVop-
tion|V10) can share JFIF and MXF video files 
with other MediaNetwork clients. Pro Tools 
cannot destructively modify video files.

Sharing Audio Files
Pro Tools clients can share audio files in an al-
location group with other MediaNetwork cli-
ents. When working with shared audio files, it is 
recommended that you use the Duplicate com-
mand to make a copies before applying any de-
structive edits.



Destructive Editing
The following Pro Tools features can destruc-
tively modify audio files:

• Pencil Tool

• AudioSuite in Overwrite Files mode

• Destructive Record

• Compact Selected

• DestructivePunch Record

• DigiBase metadata entry/editing

When working with shared audio files, it is rec-
ommended that you use the Duplicate command 
to substitute copies before applying any de-
structive edits. This avoids the problem of mod-
ifying a file referenced by another session.

To substitute a copy of a shared file:

1  In Pro Tools, select the clip you want to copy in 
the Edit window.

2  Choose Edit > Duplicate.

Rendering an AudioSuite effect in Overwrite 
Files mode will destructively modify the af-
fected clips, however, fades and metadata 
are preserved.
Chapte
MXF and OMF Files

Pro Tools treats all MXF and OMF media that 
are both created by Avid and stored on Unity 
shared storage as read-only. Consequently, de-
structive editing tools cannot be used to modify 
MXF and OMF media files. However, you can de-
lete or overwrite MXF and OMF files.

Because Pro Tools creates both MXF/OMF and 
non-MXF/OMF media files, these destructive 
editing tools can be used on non-MXF/OMF me-
dia created by Pro Tools. When you are working 
in a MediaNetwork system, you should always 
create a copy of an audio file before applying a 
destructive change.

Use the Duplicate or Consolidate commands 
in Pro Tools to make non-OMF copies of au-
dio files for destructive editing.
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Chapter 4: Avid Unity MediaNetwork 
Workflows for Pro Tools
This chapter covers workflows for using an Avid 
editing application (such as Media Composer) 
and Pro Tools to exchange AAF and OMF se-
quences using MediaNetwork shared storage, as 
follows:

• Exporting audio and video from 
Media Composer

• Importing audio and video into Pro Tools

• Exporting audio from Pro Tools for Avid 
video editing applications

• Importing audio into an Avid video editing 
application from Pro Tools

• Synchronizing audio with an Avid sequence
Exporting Audio and Video 
from Media Composer
To export sequences from Avid video editing ap-
plications for import into Pro Tools, you can 
choose from the following methods:

• Using the Send To Templates to export an 
AAF or OMF sequence

• Manually exporting an AAF or OMF se-
quence

• Checking a sequence into Avid Interplay for 
Pro Tools (Avid Interplay system required)

For more information on exporting Avid se-
quences, see the documentation that came 
with your Avid editing application.

For information on working with Interplay, 
see the Pro Tools Avid Interplay Guide.
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Using the Send To Templates to 
Export an AAF or OMF Sequence 
from Media Composer
The Send To Templates let you create one AAF 
sequence that references audio and video files 
used in the sequence, and save it to the volume 
selected in your Avid Preferences.

To use the Send To Pro Tools templates:

1  Select a sequence in a bin.

2  Choose File > Send To > Pro Tools on Unity, 
then choose one of the following options:

Link to Audio and Video Creates an AAF se-
quence that links to existing audio and video 
wherever possible and only creates new media 
files for effects that have not been rendered. 
This is the fastest and most storage-efficient 
way to export a sequence.

Choose this option for a scenario in which 
Pro Tools will link to the same media files as the 
current Avid sequence. Use this setting if the 
media files are currently stored on volumes that 
are suitable for Pro Tools media playback.

QuickTime–Link to Audio Creates an AAF se-
quence that links to existing audio, and creates a 
new QuickTime movie. Choose this option when 
exporting a sequence for a Pro Tools system that 
does not have an Avid video peripheral attached.

Video Mixdown–Link to Audio Creates an AAF 
sequence that links to existing audio and in-
cludes editing metadata as well as a video mix-
down in the video format defined by Media Cre-
ation settings. When imported into Pro Tools, 
the video mixdown and metadata are displayed 
in two separate video tracks on the Timeline.

Choose this option for any scenario in which 
Pro Tools will link to the same media files as the 
current Avid sequence.
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3  If you want to view or change export settings, 
click the Options button, and then make any 
changes. If you make any changes, you can use 
the Save As Template button to create a new tem-
plate.

4  Click Set.

5  Navigate to the location where you want the 
AAF or OMF files to reside.

6  Click OK.

The Avid video editing application exports the 
files to the destination volume. If the Avid video 
editing application has to transcode video files 
to a new resolution, render effects, or perform 
audio file conversions, a new sequence appears 
in the bin with the name filename.Export.01, 
and a new master clip appears in the bin with the 
name filename.new.01.

Send To dialog (LInk to Audio and Video options 
shown)

This workflow assumes that you use the de-
fault values. This means that you are ex-
porting using the Project sample rate, audio 
file format, and sample bit depth.



Manually Exporting an AAF 
Sequence from Media Composer
Manually exporting an AAF sequence from an 
Avid editing application involves more steps 
than using the Send To Templates, but it pro-
vides more flexibility. 

Once all effects have been rendered, export the 
sequence as an AAF sequence.

To manually export an AAF sequence:

1  Select the sequence in the bin.

2  Select File > Export.

3  Type a name and select a location for the ex-
ported sequence.

4  Select Export to Pro Tools from the Export Set-
tings menu at the bottom of the Export As dia-
log.

5  Click the Options button to open the Export to 
Pro Tools Settings dialog. Verify the settings:

• For Export As, select AAF.

• Select the Include All Video Tracks in Se-

quence option. When the sequence is im-
ported into Pro Tools. All of the video 
tracks will be “flattened” so that the im-
ported sequence shows only a single video 
stream.

You will need to render all video effects be-
fore manually exporting the sequence.
6  In the Video/Data Details tab, select one of the 
following from the Export Method pop-up 
menu:

Link to (Don’t Export) Media The Pro Tools ses-
sion will link to the same video files as the cur-
rent Avid sequence. Use this setting if the video 
files are currently stored on a volume suitable 
for Pro Tools video playback.

Copy All Media New complete video files will be 
created on the designated volume.

Consolidate Media Similar to Copy All Media, 
but only the parts of the video clips which are 
actually used in the Timeline are copied. Use 
this setting to copy the video files to a volume 
suitable for Pro Tools video playback.

Export Settings–Export To Pro Tools dialog, 
Video/Data Details tab
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Video Mixdown The exported AAF sequence will 
reference a video mixdown. This setting lets you 
have a choice of whether to export the video 
mixdown alone or the video mixdown along with 
additional video track edits. The choice depends 
largely on the version of Pro Tools to which you 
are exporting. Pro Tools 7.2 and higher can 
show the video mixdown alongside video edits; 
in this case, you should select both the video 
mixdown and the video edits. For versions of 
Pro Tools lower than 7.2, you should export the 
video mixdown by itself.

The following settings may also appear under 
the Video Details tab, depending on the selected 
export method:

Media Destinations Choose where to store cop-
ied video files.

Handle Length Extends the beginning and end of 
the consolidated file by the specified number of 
frames. This lets you trim edits later, though the 
sequence would need to be re-edited in the Avid 
video editing application.

Render Video Effects Always select Render 
Video Effects. If you already manually rendered 
effects, selecting this option will not create new 
files. It is highly recommended that all effects be 
rendered manually before exporting the se-
quence.

Transcode Video To Use this only if you need to 
change the video resolution. Pro Tools supports 
most SD resolutions supported by Avid, and 
even supports mixed resolutions in the 
Pro Tools Timeline, so in most cases there is no 
need to spend extra time transcoding the video. 
However, if you have video of a resolution which 
is not currently supported by Pro Tools, use this 
setting to transcode it to a supported resolution. 
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While new video files are typically stored in the 
OMFI MediaFiles folder (for OMF) or the Avid 
MediaFiles folder (for MXF), some workflows let 
you choose a different target destination for 
video in the Media Destination section of the 
Video Details tab, as follows:

Media Drive This option exports media to the 
OMFI MediaFiles folder or Avid MediaFiles 
folder on a connected storage drive. Select the 
Use Media Creation Settings option to use the 
default settings, or deselect that option to 
choose a media drive from the pop-up menu.

Folder This option exports video media to a spe-
cific folder. Select the Use Same Folder as AAF 
File option to export the video media into the 
same folder you designated for exporting the 
AAF sequence, or deselect this option to select a 
specific folder location for the media.

If your Pro Tools system is running on a 
slower computer, you may be able to reduce 
some of the CPU load in Pro Tools by 
transcoding the video to 1:1 on export. 1:1 
video is uncompressed, and consequently it 
does not need to be decompressed before 
playing back. However, 1:1 video requires 
significant amounts of storage space.



Embedded in AAF This option embeds the video 
media in the AAF sequence that is exported 
from the Avid video editing application. 

7  Click the Audio Details tab, and select one of 
the following from the Export Method pop-up 
menu:

Link to (Don’t Export) Media The Pro Tools ses-
sion will link to the same audio files as the cur-
rent Avid sequence. Use this setting if the audio 
files are currently stored on a volume suitable 
for Pro Tools audio playback.

Copy Media New complete audio files will be 
created on the designated volume.

Consolidate Media Similar to Copy All Media, 
but only the parts of the audio which are actually 
used in the Timeline are copied. Use this setting 
to copy the audio files to a volume suitable for 
Pro Tools audio playback.

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools.

Media Destination section of the Video Details tab
The following settings may also appear under 
the Audio Details tab, depending on the selected 
export method:

Render All Audio Effects Select the Render All 
Audio Effects option so that all audio effects are 
rendered before export. If you already manually 
rendered effects, selecting this option will not 
create new files. It is highly recommended that 
all effects be rendered before exporting the se-
quence.

Include Rendered Audio Effects Select the In-
clude Rendered Audio Effects option. Other-
wise, the exported sequence will include the 
original audio files without any AudioSuite ef-
fects from the original sequence—even if those 
effects were previously rendered.

Convert Audio Sample Rate/Bit Depth/File For-
mat Select Project for any of these, and the cur-
rent Audio Project Setting will be used.

While new audio files are typically stored in the 
OMFI MediaFiles folder (for OMF) or the Avid 
MediaFiles folder (for MXF), some workflows let 
you choose a different target destination for au-
dio in the Media Destination section of the Au-
dio Details tab, as follows:

Media Drive This option exports audio media to 
the OMFI or Avid MediaFiles folder on con-
nected storage. Select the Use Media Creation 
Settings option to use the default settings, or de-
select that option to choose a media drive from 
the pop-up menu.

Folder This option exports audio media to a spe-
cific folder. Select the Use Same Folder as AAF 
File option to export the media into the same 
folder you designated for exporting the AAF se-
quence, or deselect this option to select a spe-
cific folder location for the media.
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Embedded in AAF This option embeds the audio 
media in the AAF sequence that is exported 
from the Avid video editing application. Unlike 
embedded video, Pro Tools can import and play 
audio which is embedded in an AAF sequence. 
Embedding audio within the AAF sequence 
makes file management much simpler because 
there is only one file to move—the sequence. 
There is a limit of 2 GB for embedded AAF.

8  Click Save or Save As in the Export Settings 
dialog:

• Click Save to use the specified settings 
whenever Export to Pro Tools is selected 
from the Export Settings menu. These set-
tings will also be used when choosing any 
of the options located at File > Send To > 

Pro Tools to Unity. 

• Click Save As to save these settings as a 
preset with a different name. These settings 
can then be recalled in the Export dialog. If 
you click Save As instead of Save, the Ex-
port to Pro Tools settings will not be 
changed.

9  Click Save in the Export As dialog. (The Ex-
port Settings cannot be saved until you have se-
lected a target drive for both audio and video.)

When the export is complete, you are ready to 
import the file into Pro Tools.

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools. 
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Checking In Sequences to 
Interplay for Pro Tools Clients
The Avid Interplay media management system 
can be used in tandem with an ISIS network to 
manage media sharing between Pro Tools and 
Avid video editing application clients. For more 
information on checking in sequences to Inter-
play for Pro Tools users, see the Pro Tools 
Avid Interplay Guide.

For more information on opening and im-
porting AAF sequences in Pro Tools, see 
“Importing Audio and Video into 
Pro Tools” on page 31. For more informa-
tion on the Import Session dialog, see the 
Pro Tools Reference Guide.



Importing Audio and Video 
into Pro Tools
To import sequences exported from Avid video 
editing applications into Pro Tools, you can 
choose from the following methods:

• Importing an AAF or OMF sequence as a 
Pro Tools session

• Importing an AAF or OMF sequence into an 
existing Pro Tools session

• Importing a video mixdown into Pro Tools

• Importing an AAF sequence into Pro Tools 
from Interplay (Pro Tools Avid Interplay 
Option and an Avid Interplay system re-
quired)

Importing an AAF or OMF 
Sequence as a Pro Tools 
Session
The easiest way of using Pro Tools to edit a se-
quence exported from an Avid video editing ap-
plication is to open it as a new session. 

To open an AAF (or OMF) sequence as a Pro Tools 
session:

1  Launch Pro Tools.

2  Choose File > Open Session.

3  In the Open Session dialog, navigate to the 
AAF or OMF sequence you want to import.

4  Click Open.
5  The New Session From dialog will appear.

6  Select the I/O Settings to use for the session. 
Several pre-configured I/O Settings are included 
with your system, or you can select a custom I/O 
Setting that you have created.

7  Click OK.

8  Name your session in the subsequent dialog 
box.

9  Click Save.

The Import Session Data dialog appears.

New Session From dialog

Import Session Data dialog
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10  From the Audio Media Options pop-up menu, 
choose how you want to import audio files into 
Pro Tools:

• If the audio files reside on a volume from 
which Pro Tools can play back audio, select 
Link to Source Media (Where Possible).

• If the audio files reside on a volume from 
which Pro Tools cannot play back audio, se-
lect Copy from Source Media to copy all au-
dio to the Pro Tools audio storage or 
Consolidate from Source Media to copy 
only the portions of the audio used in the 
Pro Tools Timeline to the Pro Tools audio 
storage.

11  From the Video Media Options pop-up menu, 
choose how you want to import video files into 
Pro Tools:

• If the video files reside on a volume from 
which Pro Tools can play back video, select 
Link to Source Media.

• If the video files reside on a volume from 
which Pro Tools cannot play back video, se-
lect Copy from Source Media to copy all 
video to the Pro Tools video storage.

12  Change other parameters as desired.

13  Click OK.

Pro Tools will create a new Audio Files folder, a 
Video Files folder, a cache.wfm file, and a ses-
sion file at the designated locations. 

Pro Tools lets you open and import OMF or 
AAF sequences that reference audio files 
with mixed sample rates and/or bit depths. 
Files with sample rates other the than the 
sample rate set in the New Session dialog 
will be converted to the correct rate.
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Importing an AAF or OMF 
Sequence into an Existing 
Session
You can import an AAF or OMF sequence con-
taining audio and video media into an existing 
Pro Tools session. 

To open and import audio and/or video tracks from 
an OMF or AAF sequence:

1  Open an existing Pro Tools session.

2  Choose File > Import > Session Data, and 
choose the AAF or OMF sequence that you wish 
to import.

3  From the Audio Media Options pop-up menu, 
choose how you want to import audio files into 
Pro Tools:

• If the audio files reside on a volume from 
which Pro Tools can play back audio, select 
Link to Source Media (Where Possible).

Any video imported into Pro Tools must be 
the same frame rate as video already placed 
in the Timeline. 

Pro Tools cannot play video that is embed-
ded in an AAF or OMF sequence, but it can 
read the video editing metadata when im-
ported into a satellite track. Do not use this 
option if you want to import the video itself 
into Pro Tools. 

You can also open an AAF or OMF sequence 
by dragging it from any location on your 
computer or the DigiBase browser to the 
Pro Tools Timeline.



• If the audio files reside on a volume from 
which Pro Tools cannot play back audio, se-
lect Copy from Source Media to copy all au-
dio to the Pro Tools audio storage or 
Consolidate from Source Media to copy 
only the audio used in the session to the 
Pro Tools audio storage.

4  From the Video Media Options pop-up menu, 
choose how you want to import video files into 
Pro Tools:

• If the video files reside on a volume from 
which Pro Tools can play back video, select 
Link to Source Media.

• If the video files reside on a volume from 
which Pro Tools cannot play back video, se-
lect Copy from Source Media to copy all 
video to the Pro Tools video storage.

5  In the Import Session Data dialog, deselect any 
source tracks that you do not want to be im-
ported. (If you are importing Session Data from 
AAF or OMF sequences, all tracks are selected by 
default. If you are importing tracks from a 
Pro Tools session, no tracks are selected by de-
fault.)

6  Click OK.

If there are any errors or clip name trunca-
tions, a dialog will appear asking you if you 
want a detailed report of the changes. Click 
Yes and choose where you want to save the 
log.
7  If your audio or video source media is on a vol-
ume that is not suitable for playback (shown as a 
Transfer volume in the Workspace browser) or if 
your MediaNetwork workspace privileges are 
read-only, Pro Tools displays a dialog that 
guides you to copy the media to a volume desig-
nated for Playback or Record. (Click Yes.)

Pro Tools imports the audio and video media to 
the Timeline. Audio tracks with sample rates 
different than the sample rate of the current 
Pro Tools session are converted to the correct 
rate.

Now you are ready to edit the audio files in 
Pro Tools.

Drive Selection When Importing 
Session Data

When using the Import Session Data dialog to 
import audio files with Copy or Consolidate 
Source selected in the Audio Media Options 
pop-up menu, all new audio files are stored on 
the volumes designated for their respective tar-
get tracks in the Disk Allocation dialog.

Selecting a Unity Workspace When 
Importing Session Data

When using the Import Session Data dialog to 
import audio files with Copy or Consolidate 
Source selected in the Audio Media Options 
pop-up menu, all new audio files are stored on 
the volumes designated for their respective tar-
get tracks in the Disk Allocation dialog.

When importing video files (such as from a CD), 
the video files are copied by default to the same 
volume that holds the session file. To have the 
files copied to another volume, open the Work-
space browser, and select T in the volume desig-
nation column for all volumes except the volume 
where you want the video to be stored. To ensure 
that the files are not copied to the root level of 
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the volume, create a folder with the session 
name on the desired Unity workspace, then cre-
ate a folder within that session folder named 
Video Files.

Importing Sequences into 
Pro Tools from Interplay
The Avid Interplay media management system 
can be used in tandem with an ISIS network to 
manage media sharing between Pro Tools and 
Avid video editing application clients. For more 
information on importing a sequence into 
Pro Tools from Interplay, see the Pro Tools 
Avid Interplay Guide. 

Editing Audio in Pro Tools
Audio files created in the Avid video editing ap-
plication are either OMF or MXF files, which 
Pro Tools cannot edit destructively.

When you use Pro Tools to perform a destruc-
tive edit (such as using AudioSuite processing to 
replace the original sound), it creates a new copy 
of the file and leaves the original untouched.

See the Pro Tools Reference Guide for de-
tailed information on editing audio files in 
Pro Tools.
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Exporting Audio from 
Pro Tools for Avid Editing 
Applications
In Pro Tools, you can export audio tracks for use 
in the Avid video editing application using any 
of the following commands:

• Exporting selected tracks as an AAF or 
OMF

• Bouncing to disk

• Exporting selected clips as files

• Exporting edited audio tracks to Interplay 
from Pro Tools (Avid Interplay system re-
quired)

For other export methods, see the Pro Tools Ref-
erence Guide.

Exporting Tracks as OMF/AAF 
Sequences
Use Export Selected Tracks as OMF/AAF to ex-
port individual tracks or an entire Pro Tools 
session in AAF or OMF format.

Tracks are exported in their entirety and 
time selections are ignored.

Volume and pan automation is not retained 
on export if Quantize Edits to Frame Bound-
aries is enabled (Avid Compatibility Mode).

The Movie track cannot be exported to AAF 
or OMF from Pro Tools.



To export selected audio tracks from Pro Tools as 
an AAF (or OMF) sequence:

1  In Pro Tools, select the tracks you want to ex-
port in the Pro Tools session by Shift-clicking 
the names of each track.

2  Choose File > Export > Selected Tracks as 

OMF/AAF.

3  The Export to OMF/AAF dialog will appear.

4  Under OMF/AAF Options, choose AAF (or 
OMF) from the Export As pop-up menu.

5  Select Enforce Avid Compatibility.

Enforce Avid Compatibility creates frame-accu-
rate edits, wraps the files as OMFI (unless you 
choose MXF), and limits the sample rate options 
to 44.1 or 48 kHz. Dithering without noise shap-
ing will be applied to files being exported from 
24-bit to 16-bit.

Export to OMF/AAF dialog
6  Ensure that the Target Project Timecode For-
mat pop-up menu displays the correct frame rate 
for the Avid project. 

7  Click OK. 

8  In the Publishing Options dialog, type the 
Pro Tools Comment and Sequence Name. 

9  Click OK.

Pro Tools will create a sequence with the name 
you supply. (The Pro Tools comment appears in 
the Avid bin in a Pro Tools Comment column.)

10  In the Name the AAF/OMF File to Export di-
alog, navigate to a folder where you can easily lo-
cate the Pro Tools composition when it is time to 
import it into the Avid video editing application.

11  Click Save.

12  In the Please Choose a Folder for Converted 
Audio Files dialog, do one of the following:

An OMF sequence cannot reference MXF 
media files. In the Export Selected Tracks as 
OMF/AAF dialog, MXF is only available 
when AAF is selected in the Export As pop-
up menu

Pro Tools Publishing Options dialog

Do not save the sequence to the OMFI Media 
Files folder or the Avid Media Files folder.
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• If you are exporting to the same storage 
that Avid video editing application will be 
accessing, navigate to the OMFI MediaFiles 
folder (AIFF or WAV files) or the Avid Me-
diaFiles folder (MXF files).

– or –

• If you are exporting to a location that is not 
directly accessible to the Avid video editing 
application, navigate to a location where 
you can easily find the audio files when you 
need to copy them over to the Avid com-
puter.

13  Click Use Current Folder (Windows) or 
Choose (Mac).

Pro Tools exports the following files:

• The AAF or OMF sequence is saved to the 
folder you designated.

• If you exported audio files directly to the 
Avid video editing application’s video stor-
age, related media is saved to the appropri-
ate volume and folder (OMFI MediaFiles or 
Avid MediaFiles) accessible to the Avid 
video editing application.

14  Do one of the following:

• If you are using the Avid video editing ap-
plication on the same computer as 
Pro Tools and are ready to use it to import 
the files you just exported from the Avid 
video editing application, exit Pro Tools.

– or –

• If you were unable to save the audio portion 
of the AAF sequence directly to storage that 
is accessible from the Avid video editing 
application, copy the audio files from their 
saved location to the OMFI MediaFiles 
folder (for AIFF or WAV media) or Avid 
MediaFiles folder (for MXF media) on a 
drive connected to your Avid system.
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Exporting Audio Files Using 
Bounce to Disk
Use the Bounce to Disk command to create pre-
mixed files of the current Pro Tools session. 
This does not export all of the individual files on 
the Timeline, but it does guarantee that the mix 
you hear in the Avid video editing application 
will be identical to the mix you hear in 
Pro Tools, including all panning, effects and au-
tomation.

To export audio files using Bounce to Disk:

1  In Pro Tools, finalize the mix.

2  Select the time range of the session that you 
want to export. (All audible tracks in that time 
range will be included in the bounce, whether 
they are selected or not.)

3  Choose File > Bounce to > Disk.

4  In the Bounce to Disk dialog, select the Enforce 

Avid Compatibility option.

Enforce Avid Compatibility creates frame-accu-
rate edits, wraps the files as OMFI (unless you 
choose MXF), and limits the sample rate options 
to 44.1 or 48 kHz. Dithering without noise shap-
ing will be applied to files being bounced from 
24-bit to 16-bit.

Bounce to Disk dialog



5  Choose a file type from the File Type pop-up 
menu.

6  Click Bounce.

7  In the Publishing Options dialog, type the 
Pro Tools Comment and Clip Name.

If you selected more than one clip for export, the 
Clip Name field will not be available and the 
names of the clips will be used for the exported 
files.

8  Choose the Target Project Timecode Format. 

9  Click OK.

10  In the Save Bounce As dialog, navigate to the 
volume you will use for audio playback in the 
Avid video editing application. 

• For MXF audio files, ensure the file is saved 
to the Avid MediaFiles folder.

• For all other audio files, ensure the file is 
saved to the OMFI MediaFiles folder.

11  Click Save.

All audible audio in the selection will be ex-
ported to two multi-mono audio files.

Publishing Options dialog
Importing Pro Tools Audio 
Files Back into the Avid 
Video Editing Application
After you have checked out the completed audio 
stems to the Pro Tools sequence on the Interplay 
server, you may want to import the sequence 
back into the Avid video editing application.

For more information on importing Pro Tools 
audio into an Avid application with Interplay, 
see the Pro Tools Avid Interplay Guide.
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